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How to 
Use This 
Guide 

Welcome to N -S Chart. 

The N-S Chart program is a Nassi-Shneiderman Diagram 
development tool. This manual, N-S Chart User Guide, 
shows you how to use the various parts of the program. It 
does not teach you how good Nassi-Shneiderman diagrams 
should be drawn. · 

• If you want a brief lesson on getting started with N-S 
Chart, see "Learning About N-S Chart." You should be 
able to follow this chapter easily, even if you've never 
drawn a Nassi-Shneiderman chart before. 

• For more detailed information on how to use N-S Chart, 
look through chapter 2: Using N-S Chart. 

• For a brief sp.mmary of the various features ofN-S Chart, 
see chapter 3: Reference. 

If you are wanting more detailed information about the 
program, refer to the separate volume "N-S Chart Project 
Report" 
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Learning 
Hbout 
ll-S Chart 

Anatomy of the N-S Chart screen 

After starting-up N -S Chart the screen should look similar 
to the picture below- without the clipboard and page view 
windows. 

rl'he page view window shows how the whole chart will look on paper 

•"" Tool palette for selecting symbols, 
A starting 'blank' Nassi
Shneiderman chart. 

tools and drawing modes. 

Menus for creating, editing and manipulating your diagrams, 

fi File Edit Chart Settings Fonts Styles Windows 

Untitled 1 Uiew 

Clipboard 

1 ........ :o::·ee e••••u•••••••••etu•••e•••ue*O'!''!,.eu• 

Several chart 
windows may 
be open at once. 

The chart window. You create and edit your charts here. 
The pointer (takes 
different shapes 
depending where 
it is and what tool 
you are using). 

The clipboard window. Shows what will be pasted. 

If N-S Chart was started by double clicking on a chart file, 
that file will be opened and it's top level chart window will be 
displayed. 
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Opening a 
Chart 

If you selected chart files to be printed from the finder, N-S 
Chart will start-up, print the charts in full, and the 
automatically close down again. 

A blank N assi -Shneiderman chart window (like the one 
shown above) will be opened if no charts were selected. 

Opening a saved chart 

• Choose Open ... from the File menu. 

A dialog box like this will appear on your screen: 

I (g) Project I 
Gl Euc:lids Rlgorithm ' ~ 
D N-S Proj Files 
D Sample Chart 

• Click the name Euclids Algorithm. 

• Click the Open button. 

(g) Project 

( Eject ) 

( Driue ) 

( Open ) 

( Cancel J 

A new chart window will appear (in the first available slot) 
with the Euclids Algorithm chart in it. 

Note that if you already had a Untitled blank chart open 
when you opened Euclids Algorithm chart, the other chart 
will still be open. You may open up to 8 totally separate 
charts in this way. 
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Drawing 
Charts 

Drawing Symbols 

Symbols are added to a chart by selecting a symbol tool and 
clicking on the diagram where you want it inserted. When a 
symbol tool is selected, the cursor will change to a pointing 
finger. 

• Click on the HEise symbol icon in the tool palette.~ 

The square will become highlighted to indicate the current 
tool. (A summary of what each of the tool palette icons mean 
can be found in chapter 3). 

• Click on the Input symbol at the top of the chart. 

A blank IfElse symbol will be inserted into the chart after the 
Input symbol. 
When symbols are added to the chart in this way, they may 
be inserted after the symbol clicked on, or they may replace 
the symbol clicked on. 

• Click the Replace Mode icon at the bottom right of the tool 
palette. 

• Select the Process symbol tool and click on the IfElse 
symbol you added just before. 

The process symbol will replace the IfElse symbol and the 
chart will be resized appropriately. When ever you make 
changes to a chart, N-S Chart will automatically resize 
everything to keep the chart neat and tidy. 

To keep things balanced, N -S Chart sometimes inserts 
special process symbols called Fillers into the chart. These 
are coloured light gray to help you distinguish then from 
ordinary symbols. 

The insert/replace mode may be changed at any time by 
clicking one of the two icons at the bottom of the palette. 
Notice that two of the tool palette icons will always be 
highlighted. One indicates the insert/replace mode, and the 
other the current drawing tool. 

You may have found above that when you clicked on a 
symbol in the chart to add another, the new symbol did not 
appear where you expected. 
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Revert 

All the symbols look rather different but they share the same 
basic parts shown below: 

• Symbol Area ~ Inside Symbol 

To click on a symbol you must click on the areas shown 
above in gray. If you click on the diagonal shaded area, you 
will actually be clicking on a different sub-symbol. 

If you have made some changes to a chart that you think you 
are better off without you can revert back to the original 
version of the chart. 

• Choose R e u e rt from the F i I e menu. 

A box like this will appear: 

Are you sure you want to reuert to the 
last saued uersion of chart "A Mess .. ? 

( Yes ) ( Cancel ) 

• Click Yes to bring back the original chart. 

If something goes wrong: Don •t Panic! 
If you do something wrong that N-S Chart thinks it should 
warn you about, a box similar to the one below will appear 
(the message may be different, but the*! will always be 
there). 
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Help 

A process symbol has not been properly selected and so a 
subchart can not be created. 

• Click anywhere in the box to make the message go away. 

Some messages advise you that you are trying to do 
something the wrong way (like the one above) and often give 
clues as to the right way to do it. Others just warn that what 
you have tried to do should not be done and tell you why you 
can't do itl 

On-line Help 

N-8 Chart has a built-in help function that contains 
information on how to use many of its features. To be able to 
use Help, you must have the N-8 Chart Help File in the 
same folder as your N-8 Chart application. 

• Choose About N-S Chart ••• from the 8 menu. 

The 'about' box will appear: 

(NASSI-SCHNEI DERMAN CHARTOGRAPHER J 
Deueloped by 
A. B. Couch 1988 
Uersion 1.1 

Written in lightSpeedrM Pascal 
using EHtenders™ libraries. 

( OK ) ( Help ) 

• Click on the Help button ... 

- 9-



A 'bo-ut Nassi-Shneiderma.n Cart?ir&.pher. 
Clipboard - the cha.rt clipboard. 

N-S Ce.rtoir&.pher 1.0 

A. B. Co-uch 1988 

Defaults - parEU'tl('ters -used when cres.ti~ &. MW cha.rt 
Desk a..ccessories - c&.n be -used as nor:m.&.l. 

.(Cancel) Dr e. w - redre. ws the cha.rt. 
Edi ti~ - modi fin& e. cha.rt. 

[ Help J Erase -irreversibly deletes the c-urrent windows char 
Files - 1oe.di~, s&.vi~, closi~ etc . 

Quitting 

... and the topics dialog will appear. To get help on a topic, 
select it and click on Help. Another window will open with 
information on that topic. 
You can return to the dialog above by clicking the Topics 
button. 

Leaving N-S Chart 

• Choose Quit from the F i I e menu. 

If you have made changes to any of the open charts, N-8 
Chart will ask if you want to save changes before quitting: 

Do you want to saue 11 Sample Chart II 
before quitting? 

Yes ( No ) ( Cancel ) 

If you press Yes the changes you have made will be saved to 
the chart file. 

If you click Cancel, N-8 Chart will not quit. 
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Chapter 2: 

Using 
n-s Chart 
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new 
Charts 

Entering 
Text 

Getting a New Chart 

To obtain a new 'blank' chart window: 

• Choose New from the F i I e menu. 

A new window will be opened with the standard Input-
Filler-Output chart. · 

Input Data 

Output Data 

' 

Entering Symbol Text 

To enter text into a symbol: 

• Select the Text tool from the palette. 

• Click on the symbol. 

A dialog box like this will appear: 

Enter symbol teHt: K OK ll( Ca~cel ) 

• Type the text for the symbol. It may as long or short as 
you like. You can use return to separate lines. 

• Then click the 0 K button. 

As much of the text as possible will be drawn in the symbol. 

The text in a symbol may be edited at any time by clicking on 
it with the Text tool. 

The top part of IfElse and Case symbols is split into several 
parts for entering text. The top upside-down triangle 
contains the main caption for the symbol. The text in this 
triangle is always centred in the symbol. 
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Insert 
Before/ 
Rfter 

Selecting 
symbols 

The other polygons show captions for the various 
alternatives of the symbol. To enter text into these, just click 
inside the appropriate polygon. 

Insert Before/Mter mode 

When the IfElse symbol was drawn in chapter 1, it was 
inserted after the symbol clicked on. A symbol may be 
inserted before the symbol clicked on by changing the insert 
before/after mode. This option only applies when in insert 
mode- not when in replace mode. 

• Choose Insert Before from the Settings menu. 
• Select Insert mode (by clicking on the insert icon on the 

palette). 
• Click on one of the Do While symbols in the middle of the 

chart. 

The symbol will be added before the symbol clicked on. You 
may return to i.nsert after mode by choosing I n s e rt After 
from the Settings menu. 

Cutting, Copying and Clearing 

Cutting and pasting on symbols works similar to cutting 
and pasting of text. You first select the symbols in question, 
and then choose the required action. 

Text is selected.with the Grab tool. The cursor is changed to 
a hand to help you remember you are using the grab tool. 

• 
To select a single symbol, just click on that symbol (in the 
area shown in gray in chapter 1). 
To select several symbols, click down on the first one and 
drag the hand up or down the chart. The selected symbols 
will become highlighted. 

You can select an entire chart (less the Input and Output 
symbols) by choosing S e I e c t A II from the Edit menu. 
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moving 
and 
Copying 

Pasting 

(Input and Output symbols can never be copied since it does 
not make sense to have more than one pair per chart). 

Typing the Backspace key or choosing C I e B r from the Edit 
menu erases the selected text. 

You can move symbols form one part of a chart to another, 
or even from one chart to a different chart . . , 

• Select the symbols to be moved. 

:= b 

• ·Choose Cut from the Edit menu. 

The selected symbols are deleted from the chart and copied 
to the clipboard. They may be viewed at any time by opening 
the clipboard window: 

• Choose ClipboBrd from the Windows menu. 

D ClipboBrd 

while (x > !-J) do 
lx ·- X - y .-
while (!-1 > x) do 
I w := w- X 

Now that the symbols are in the clipboard, you can insert 
them anywhere in your charts. 

• Select a symbol with the Grab tool that you want the 
symbols to follow. 

• Choose PBste from the Edit menu. 
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Saving 
Charts 

The symbols will appear after the selected symbol (if in 
Insert After mode) or before the selected symbols (if in Insert 
Before mode). 
Pasting does not remove the contents of the clipboard; it only 
puts a copy at the selected symbol. Thus, you can make 
several repeated copies if you like. 

Ifyou want to copy selected symbols to the clipboard without 
erasing it, choose Copy instead of Cut. 

Saving a Chart 

Any chart may be saved to a file for future use. N-S Chart 
does not just save diagrams as a picture, but rather in it's 
own special format. 

• Choose Sa u e from the F i I e menu. 

If the chart has not been saved before, a dialog box will 
appear to allow you to enter a file name: 

I (g) Project I 
D [!H:Hd~ HI!JtHithm 
r.J N .. s 1: ht~rt th~tp 
D N .. S H~~lp 
D N-S Proj Files 
D N .. S i> r o j ~~ c 1 4 
D Pro je< trsn 

Enter Chart name 

Euditls Algorithm 

(g) Project 

( Eject ) 
( Drive ) 

( Save ) 

( Cancel J 

You may browse files already on the disk, or even change 
disks and folders. If you decide against saving the chart, 
you may abort the operation by clicking Can c e I. 

If the chart has been saved before, no dialog will appear and 
instead the chart will be saved to the same file as before. 

You may save a chart to a file of a different name or on to 
another disk with the Save As .•. command. The box above 
will be displayed. 
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Saving 
Pictures 

Fonts 

Text Style 

Saving a Chart in PICT format 

Rather than just printing completed charts on a page by 
themselves, you often will-want to include them into 
documents and reports. 
N -S Chart allows you to do this by providing an option to save 
charts as pictures. 

• Choose Salle Picture ... from the File menu. 

A box like the one above will appear for you to specify a name 
for the picture file. The chart is saved in the standard PICT 
format rather than just a MacPaint bitmap. This means the 
picture files are completely compatible with applications like 
SuperPaint, MacDraw and 8Draw. 

If a N-S Chart generated picture file is opened, it will 
automatically start up MacDraw. Each element of the 
picture may be edited as with any picture in MacDraw. 

Fonts, Type Size and Style 

The font for a chart may be changed by selecting the font 
name from the Fonts menu. 
The default font is Beverly Hills which is built in to N-S 
Chart. and so will always be available. 
When a new font is chosen, all text in the current chart is 
changed to that font. 

The type size may be specified by choosing a nwnber from 
the Styles menu. The available sizes are shown in 
((Jl11!Un1Dl<e. 

Again, choosing a new type size causes all the text in the 
current chart to be changed to that size. The type size has no 
direct relationship with the Line Height (q.v.) so if a large 
size is used, it may be necessary to change the line height to 
make the text readable. 

The current type style may be set by selecting various 
combinations from the Sty I e s menu. 
Whenever a new symbol is added to the chart, it records with 
it the current text style. The symbol style is also set when 
entering new text into a symbol. 
A chart may be shown in all the same style (the current 
style) or with each individual symbol in it's own style. 

• Choose Unique Style from the Settings menu. 
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Line 
Height 

Chart 
Width 

This will redraw the chart showing all text in it's own style. 
(It won't look any different if you haven't entered any text, or 
you haven't changed the style). 
To change back to drawing the chart all in the current style: 

• Choose Uniform Styles from the Settings menu. 

Setting the Line Height 

All symbols are an integer number of 'lines' high. The size 
on one line can be set with the line height option. 

• Choose Line Height from the Settings menu. 

A box like this will appear: 

Enter Line height: ~~~ 

[ OK ~ (Default) ( Cancel ) 

Type the new height for lines in pixels. A useful guide is to 
set the line height to about two to four pixels taller than the 
font point size you are working with. Experimentation will 
show what size you think looks best. 

Chart Width 

The width of each symbol added to a chart is automatically 
set depending on where it has to fit. Nevertheless the overall 
width of a chart diagram may be changed: 

• Choose Chart Width from the Settings menu. 

The following box will be displayed: 

Type new width: 

[ OK ) (Default) ( Cancel ) 

The maximum width is 600 pixels which is equivalent to the 
width of an A4 page. Clicking the De fa u It button sets the 
chart width to the default of 300 pixels. 
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Defaults Chart Defaults 

• Choose Defaults .•. from the Settings menu. 

A dialog box like this will appear: 

The default overall The font size a new 
w idth for a new chart. chart will start with. 

Th e height oflnput and 
0 utput symbols (in ...... The default line 
lin es), for new charts. height for a new chart. 

The width ofthe 
upright on th e 
left of Do Whi le, 
DoUntil and 
Block symbol s 
for a new cha rt. 

N W CHR, T OEFRULTS \ 
..+---~ 

Chart Width 1300 I Font Size I "12 I 
line Height 116 I Upright Width 17 I 

In/Output lines 12 I 

CURRENT CHART 

-Justify, TeHt: @Left 0 Centre 0 Right 

s h ad e Fillers: - [8:1 I n Win dow D 0 n P a p e r 

(( OK 'I 

Sets the justification 
of text within symbols 
for the current chart. 

Accepts and sto~es ~ 
away your settmgs. 

(Defaults J 

Reverts everything to 
the standard defaults. 

Colour the filler 
~ symbols with gray? 

The default Default settings are: 

Chart width = 300 pixels 
Line height = 16 pixels 
Input and Output symbol height = 2lines 
Font Size = 12 point 
Symbol upright width = 7 pixels 
Text justification = Left 
Shade filler symbols in window = Yes 
Shade filler symbols on paper = No 
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( Cancel 

Click here if you 
don't want to 
change the default 
after all. 



Settings 

When you start-up N-S Chart, a new chart will have these 
attributes. 

Symbol Settings 

• Choose Symbol Settings ... from the Settings menu. 

The settings dialog looks like this: 

Indicates the number of 
lines high a new process 
symbol will be drawn. 

Specifies the number of alternatives 
the Case and Parallel symbols will 
start with. 

CHART SETTINGS 

I f-Eise Height [0 
Case Height EJ 
No. Case/Parallel Alternatiues 

Click here 
to record the 
settings. 

Defaults 

Click on this 
button to revert 
to the default 
settings. 

The default chart settings are: 

Process symbol height 
IfElse symbol height 
Case symbol height 
Do While, DoUntil and Block symbol height 
Parallel and Case symbol alternatives 

D 
D 

Cancel 

Click here ifyou 
made a mistake 
and don't want to 
change the settings. 

= lline 
= 2lines 

= 3lines 
= lline 
= 3 cases 

The symbol settings allow you to customize the size of new 
symbols drawn. 
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Grow and 
Shrink 

Case 
Symbols 

Closing a 
Chart 

You can change the shape of symbols that are already in the 
chart with the Grow and Shrink tools. 

II 
To enlarge a symbol, select the Grow tool and click on the 
symbol. The symbol will be enlarged by one line. Keep 
clicking on the symbol to make it even bigger. You can 
make a symbol as large as you like. 

To make a symbol smaller, use the Shrink tool. Each time 
you click on a symbol it will be shortened by one line. You 
can not make a symbol shorter than one line high. 

Altering Case and Parallel symbols 

When created, a Case or Parallel symbol starts off with the 
default number of alternatives. You can add more cases or 
delete cases with the Add Case tool and the Delete Case tool 
respectively . 

. The Add Case tool works just like inserting new symbols. 

• Select the Add Case tool on the tool palette. 
• Click on the symbol the new alternative is to be inserted 

after (before). 

The Insert Before and Insert After options in the 
Settings menu also apply to inserting cases. 

To remove an alternative: 

• Select the Delete Case tool. 
• Click on the top symbol in the case to be deleted. 

All the symbols in the alternative will be deleted, and the 
chart will be redrawn adjusted appropriately. 

Closing Charts 

• Choose Close from the File menu. 

If you have made modifications to the chart since you opened 
it, or last saved it, a dialog like this will appear: 
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Do you want to saue "The Chart" before 
closing? 

( Cancel ) 

If you press Yes the changes you have made will be saved to 
a chart file. If you haven't saved the chart before, the Sa u e 
dialog will be displayed for you to enter a name for the file. 

If you click the Go-Away box of a new (or like new) chart, it 
will be closed (without saving it)- a new one can be opened 
again if needed. 

Sub c::h arts Creating and Removing Subcharts 

Generating 
Pascal 

N-S Chart supports the building charts in a hierarchical 
manner. A whole subchart may be represented by a single 
process symbol in the parent. To make a subchart: 

• Select a process symbol. 
• Choose New Sub chart from the Charts menu. 

A new window will be opened with the 'blank' subchart in it. 

A symbol with a subchart is drawn with a gray border to 
remind you it is special. The subchart window can be 
opened from it's parent by double clicking on this symbol. 

To delete a subchart: 

• Select the symbol that represents the subchart. 
• Choose Remoue Subchart from the Charts menu. 

The subchart and all it's decendents will be deleted. 

Generating Pascal 

N-S Chart can··generate pseudo Pascal directly from a Nassi
Shneiderman chart. Each of the symbols are converted to 
the corresponding Pascal control structure. (Any parallel 
processing symbols can be turned into Pascal but are 
inserted into the code as comments). 

• Choose Generate Pascal. .. from the Chart menu. 
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A box like the one below will appear: 

Put comment 
brackets around 
the text in 
symbols. 

The number of 
spaces used for 
one indent 

Add semicolons 
at the end of 
lines (in the 
appropriate 
places) ? . 

ENERRTE PA 

Put comment 
brackets 
around HEise 
and Case 
conditions. 

Bracket : IZ! 

Indentation 13 

mbol TeHt D If /Case Labels 

IZI Add Semicolons 

IZI Add Program Header ~Use Otherwise 

OK Defaults Cancel 

Click here to Click her.e 
to continue. continue with default 

settings instead ofthe 
ones shown. 

Click this button if 
you've changed 
your mind about 
generating Pascal. 

Add a 'progra~' 
header to the Pascal 
file. 

Specifies whether the last alternative in a case 
statement should be coded as an otherwise case. 

This dialog allows you to specifY various options for 
generating the code. 
When you click OK, this next box will appear: 

I (g) Project I 
r.:! [UCJid~ HI!J!Hithm 
D N .. S t: hort lh~lp 
D N .. S lh~lp 
D N-S Proj Files 
D N .. S P r o j ~~ e 1 4 
D Pro je< trsn 

Enter Pascal file name: 

Untitled 1 Pasc:al 

-22-
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(g) Project 

( Eject J 

( D riue J 

( Saue J 

( Cancel J 



Printing 

• Enter the name of the file to which you want the pseudo 
Pascal written. 

When you click Saue the code will be generated and saved to 
a text file of that name. 
You may read the file into any other application for editing, 
compiling etc. 

If you click Can c e I in either of the two dialog boxes, no file 
will be written:· 

Printing Charts 

When working with large charts, it is always helpful to have 
a hard copy of the whole chart in front of you. Scrolling 
windows are nice, but sometimes a paper printout of the 
chart makes it easier to follow. 

To set up for printing your chart: 

• Choose Page Setup ... from the File menu. 

This dialog box will be be displayed: 

Selects standard American 
81/2" x 11" or 81/2" x 14" 
paper Size. 

Selects standard European 
metric paper sizes. 

Click here to put 
the selections 
you ve made into 
effect. 

RppleTal k I mageWriter 

Paper: ~®US letter 
"'-'0 US legal 

""'0 R4letter 
v2.6 ~~iiiiiiiiiiiioiiiiiiiiiiii~K~J 

- 0 International Fanfold ( Cancel J 
0 Computer Paper 

Orientation Special Effects: D Tall Adjusted 
~ D 50 % Reduction 

D No Gaps Between Pages 

Prints the chart at half size. Click here to cancel any new 
selections you have made 

This dialog does not actually cause your program to be 
printed. It only allows you to specifY how you want the 
printing to be set up on the page. 
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Ifyou've already selected how you want printing to be done 
once before, and you don't want this printout to be any 
different, then you can skip doing a Page Setup. 

To get a printout of your whole chart: 

• Choose Print All ... from the file menu .. 

A dialog box like this will appear: 

Selects whether you want the printout to be 
extra crisp and sharp or not. "Best" quality 
takes longer to print. Draft quality should 
not normally be used since only symbol 
text is printed - not the actual symbols. 

Selects the range of 
pages to be printed. Not 
used by N-S Chart since 
a chart must always fit 
on one page. 

AppleTalk I mageWriter "PorterHouse" 

Quality: ~ 0 Best ®Faster 0 Draft 
v2.6 

Click here to 
start printing. 

I[ OK JJ 

Page Range: @All 0 From: II ITo:O ( Cancel ) 

+1 I Copies: 

Paper Feed: @Automatic 0 Hand Feed 

Selects the number of copies of 
your chart you want printed. 

Selects whether the printer will 
be printing on fan-fold paper or 
individual sheets. 

Click here if you have 
decided not to print after 
all. 

To print a single chart, rather than the whole hierarchy of 
charts: 

• Choose Print ... from the file menu. 
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Chapter 3: 

Reference 
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About N-S Chart ... 

Suitcase 3CK 
Acta 
Camera 
Chooser 
Control Panel 
Oisklnfo 
Key Caps 
McSink 
Scrapbook 

Atiout N-S C:hart ... 

Tells you about the 
version ofN-S Chart 
you are working 
with. The help topics 
dialog is displayed 
when the Help button 
on the About dialog is 
pressed. 

The rest of the 
choices on this menu 
are standard 
Macintosh desk 
accessories. 
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New 3€N 
Open... 3€0 

Close 
Saue 
Saue As ... 
Reuert 

Saue Picture ..• 

Page Setup ... 
Print... 3€P 
Print All ••. 

Quit 3€0 

Creates a new, empty 
chart window named 
Untitled for you. 
You can give it a new 
name with Saue, 
Saue As ... or Chart 
Name. 
The window starts off 
with an empty chart. 

Open... · 

Puts up a dialog box 
that lets you browse 
the chart files that N
S Chart knows about. 
When you choose one 
of the files, it appears 
in a new chart 
window. All of the 
charts subcharts are 
available in Window 
List. 

C:lose 

Closes the current 
chart and all of it's 
subcharts. All 
windows of the chart 
are closed. If you 
have made any 
changes to the chart 
that you haven't 
saved, it asks you 
first ifyou want to 
save .them. 

saue 

Saves changes made 
to your chart. If the 
chart is a new one 
(named Untitled or 
not saved yet), it asks 
you first for the 
programs name, like 
saue As ... 

Satte Rs ••• 

Puts up a dialog box 
that lets you save the 
current chart under 
a new or different 
name. It also lets 
you select which disk 
and folder the 
program will be 
saved in. 

Rellert 

If you have made 
changes to a chart 
that you have decided 
you are better off 
without, you can 
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bring back the last 
version of the chart 
you saved with 
Reuert. Reuert will 
always double-check 
with you before 
reverting, just to 
make sure you don't 
want the current 
version. 

Satre Ri(:ture ••• 

Saves the current 
chart as a picture 
(PICT format). Save 
picture puts up a 
dialog box for you to 
enter a name for the 
file you want the 
picture saved to. The 
picture can be loaded 
and edited using 
MacDraw or other 
similar applications. 

Rage Setug ••• 

Lets you tell N -S 
Chart what kind of 
paper you're going to 
be printing on: what 
size the paper is and 
what size you want 
the charts printed. 

Rrint... · :~:R 

Puts up a dialog box 
that lets you tell N -S 
Chart how the 
printing should be 
done: what quality 
the printing should 
be, how many copies 



to print and whether 
it can expect the 
paper to be fed 
continuously or a 
single sheet at a 
time. 

Rrint All ... 

Does the same thing 
as Print, except that 
all the subcharts of 
the current chart are 
printed, rather than 
just the front chart. 

Returns to the 
Finder. If you've 
made changes to any 
chart that you 
haven't saved yet, it 
asks you ifyou want 
to save them before it 
quits. 

IJntio 

Cut 3€H 
Copy 3€C 
Paste 3€U 
Clear 

Erase 3€E 

Select All 

,.. t ·::u:·H .... u •:11:• 

Removes the selected 
symbols and places 
them in the 
clipboard. Any 
symbols previously in 
the clipboard are 
overwritten. 

,.. 0 y •::U:• ,.. 
ll:.'< n t:t't4 ..... 

Does the same thing 
as Cut, except that 
the selected symbols 
are not removed; only 
a copy of them is 
placed in the 
clipboard. 

Inserts a copy of the 
symbols in the 
clipboard after the 
selected symbols 
when in Insert mode, 
or in place on the 
selected symbols in 
Replace mode. 
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(:lear 

Similar to Cut, 
except that the 
symbols are not 
placed in the 
clipboard, they are 
simply removed. 

Clears the current 
chart to a blank chart 
and deletes all 
sub charts of the 
current chart. E r a s e 
will always double
check with you, to 
make sure you really 
want to erase the 
chart. 

seun:t on 

Causes all symbols 
between the Input 
and Output symbols 
in the current 
window to become 
selected. 

Note: 

Edit menu choices 
may not be applied to 
symbols in the 
Clipboard window. 



New Subchart 
Remoue Subchart 

Include Subchart 
Make Subchart 

1: ollt~ps(~ 
1: H Jl<ln d 

Generate Pascal ... 

Draw 

h-lem Subc:hart 

Opens a new 
subchart window 
from the first of the 
selected symbols. If 
the selected symbol 
has no caption, it is 
given the name of the 
sub chart. 

Remoue Subc:liart 

Removes the 
subchart (and and all 
it's children) that the 
selected symbol 
stands for. It will 
always check with 
you to make sure this 
is really what you 
want to do. 

I nduUe sub£:hart 

Replaces the selected 
symbol with the 
symbols in it's 
subchart. All the 
symbols' subcharts 
are preserved. 

Niak'e Sub£:hart " 

Places a process 
symbol in place of the 
selected symbols and 
creates a new 
subchart, placing the 
selected symbols in 
the subchart. 

Collapses the selected 
symbols into a single 
process symbol. The 
symbols are not 
deleted, but just 
hidden from view. 
They can be seen by 
using the Inspect 
tool. 

EHpanU 

The opposite of Make 
Subchart, this 
option inserts hidden 
symbols back into the 
chart. The process 
symbol that marked 
their' place is 
removed. 
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Generate Ras£:al ••• 

Opens a dialog to let 
you select options 
about the code to be 
genera ted, then a 
dialog to allow you to 
browse files on the 
disk and select a file 
name. Pseudo 
Pascal is generated 
and saved to this file. 

Dram 

Redraws the chart in 
the current window. 



Settings 
Chart Width WW 
line Height Wl 
Chart Name 

Defaults... WD 
Symbol Settings... WS 

Unique Style WU 
Insert Before WI 

c:ttart nmntt :~:m 

Lets you enter a new 
width for the current 
chart. The 
maximum width is 
600 pixels. 

mne Height :~:I] 

Allows you to set the 
line height - the 
height of a symbol 
one line high. 

Sets the name of the 
current window, and 
hence the name of 
the current chart. 

Defaults... :~: D 

Lets you change the 
default settings for 
creating a new chart 
and the chart 

defaults for the current 
chart. 

symbol Settings... :~:s 

Brings up a dialog to 
let you alter the 
default settings for 
symbols. New 
symbols created will 
use these values. 

Unique Style :~:u 

Switches the style 
mode from Uniform 
Styles to Unique 
Styles. 

Uniform styles :~:u 

This is the opposite of 
Unique Style. It 
switches from 
Unique Styles to 
Uniform Styles. 

1 nsert Before · :~:I 

This option changes 
the insertion mode. 
The mode is changed 
to Insert Before. 

I nset"t After :~:I 

This is the opposite of 
1 nsert Before. It 
switches from Insert 
Before mode back to 
Insert After. 
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Chicago 
V"'Geneua 

Monaco 
Times 

This menu lets you 
select the font to be 
used for the current 
chart. When the font 
is changed, all text in 
the chart is changed 
to that font. 

V"'Piain 
Bold 
1/o/ic 
Underline 
mrnao~mrn 
~ uumfl cmm 
Condense 
EHtended 

ID IPm~ma 
u m IPm~ma 

V"'D ~ IPm~ma 
14 Point 
u m IPoo~rna 
24 Point 

rrhe top section in 
this menu allows you 
to select the style for 
symbol captions. 
This style is used 
when a symbol is 
created and 
whenever the text of 
a sy:r;pbol is changed. 
The current style is 
used to draw the 
entire chart when in 
Uniform Style 
mode. 
To get different styles 
for each symbol, use 
Unique Styles 
mode. 

The second part of 
the Styles menu 
selects the point size 
for text. Proper point 
sizes are shown in 
10nULUilllll.<e. The other 
sizes may be used, 
but will look a little 
rough. 
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lltiOi:IOILJS 

Window List ~L 

Palette 
Page Uiew 
Clipboard 

Chart One ~ 1 
Chart Two 3€2 
Untitled 3 ~3 

H !J!~ il ~~ h h~ :~: ~ 

·i Hlini:lom List :~:1. 

Puts up a dialog box 
that lets you peruse 
the windows (charts) 
that are open in N-8 
Chart. If a window 
is selected it is 
opened and brought 
to the front. 

'Ralette 

Redraws the tool 
Palette at the left of 
the screen. This 
may be necessary 
after using some 
desk accessories or 
after a screen saver 
like Pyro. 

~ Rage Llieil• 

Causes the Page 
Uiew window to 
become active. This 
window shows you 
how the chart will be 

positioned on the 
printed page. 

E:lipboard 

Causes the 
Clipboard window 
to become the active 
window. When ever 
you Cut or Copy 
selected symbols, the 
symbols are copied to 
the clipboard. The 
Clipboard window 
always displays the 
contents of the 
clipboard. 

Untitled 3 :~:3 

The names that 
actually appear in 
the last section of 
this menu depend on 
the names of your 
charts. For 
instance, if you have 
a chart called De m o, 
Demo would appear 
in this menu. 
The names of all top 
level charts will 
appear here. 
Choosing a name 
causes the window 
with the chart of that 
name to become the 
active window 
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Tool Palette 
Reference 

~ --
[0 [Q 
[Q ~ 
~ ABC 
<> ~ 0 

[iJ fi1 
C\ f7 
0 
a [IBJ 

l!d 

~ 
~ 
[Q] 
[g) 

~ 
~ 
~ 
~ 
~ 
ill] 
~ 
~ 
~ 
@] 

~ 

Process Tool - Gives a process symbol. 

If Else Tool - Gives an IfElse symbol. 

Do While Tool - Gives a Do While symbol. 

Do Until Tool- Gives a Do Until symbol. 

Block Tool - Gives a Block symbol. 

Case Tool - Gives a Case symbol. 

Parallel Processing Tool - Gives a parellel 
symbol. 

Text Tool - Brings a up a dialog box to enter a 
symbol caption. 

Shrink Tool - Reduces the height of the sym
bol by one line. 

Grow Tool- Increases the height of the sym
bol by one line. 

Add Case Tool- Adds an other alternative to 
a Case symbol. 

Delete Case Tool - Removes the indicated case 
from a Case symbol. 

Inspect Tool- Shows the contents of a col
lapsed symbol. 

Grab Tool - Click and drag with this tool to 
select symbols. 

Up One Button- Closes the current subchart 
and opens the subchart's parent chart. 

Insert Mode Switch- Changes from Replace 
mode to Insert Mode. 

Replace Mode Switch - Changes from Insert 
mode to Replace Mode. 
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